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Welcome to the CRM for Outlook 

Basics guide 

This guide contains the essentials you need to use Microsoft Dynamics CRM for Outlook, the 

Microsoft Outlook add-in that works together with Microsoft Dynamics CRM. In this guide, we’ll 

show you how to navigate CRM for Outlook, enter and edit data, and move your customers 

successfully through the sales cycle.  

We know you’re busy, so we only included what you need to know to get productive right away, 

and we kept every topic as short as possible (think bite-sized servings!).  

Have it your way 

You can read this guide straight through in order, or read just the topics you’re interested in. If 

you’re the person responsible for training people at your organization, you can use the guide to 

walk through the topics in training sessions.  

Create your own training materials  

To make it easier for you to create your own training materials, we’re giving you a link to our 

editable files, so that you can replace screen shots, change the text, or use your own logo—

whatever works to make the training materials match your system and style.  

Find more answers and training online 

If you’re new to Microsoft Dynamics CRM, you may also want to check out our CRM Basics 

eBook. It covers the same content as this guide, but from the perspective of the Microsoft 

Dynamics CRM web client.  

To find more eBooks, videos, and other great content to help you get the most out of Microsoft 

Dynamics CRM and CRM for Outlook, check out the CRM Customer Center from your favorite 

device at www.CRMCustomerCenter.com. 

Talk to us 

Is this the kind of guide you’d like to see more of? Did we leave something out you’d 

like to know about? We’d love to know what helps you, or what doesn’t work so well. 

Please take a minute to send us a quick note. We’ll use your feedback to improve our 

content. 

http://www.microsoft.com/en-us/dynamics/crm-customer-center/training-adoption-kit-for-microsoft-dynamics-crm.aspx
http://www.microsoft.com/en-us/dynamics/crm-customer-center/training-adoption-kit-for-microsoft-dynamics-crm.aspx
http://go.microsoft.com/fwlink/p/?LinkID=512927
http://go.microsoft.com/fwlink/p/?LinkID=512927
file://tkzaw-pro-19/MyDocs4/brycho/My%20Documents/CRM%20for%20Outlook%20Basics/Tech%20Review/www.CRMCustomerCenter.com
mailto:mscrmdf@microsoft.com?subject=eBook:%20CRM%20for%20Outlook%20Basics%20Guide(/1:help/2:V7/3:V7/4:eBook-CRM-Basics.htm/5:None/6:en-us/7:OP/8:CRM)&body=Thanks%20for%20taking%20the%20time%20to%20send%20us%20your%20feedback.%20What%20would%20you%20like%20to%20let%20us%20know%20about%20the%20CRM%20for%20Outlook%20Basics%20guide?
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Meet CRM for Outlook 
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A new, but comfortably familiar face 

If you’re like many people, you already use Microsoft Outlook as your communications, 

scheduling, and contact management hub. But maybe you’re new to Microsoft Dynamics CRM 

and all that it has to offer? With CRM for Outlook, a free add-in for Microsoft Outlook, you can 

take advantage of what you already know about Outlook to make it easier to learn and work 

with Microsoft Dynamics CRM.  

 

When you install CRM for Outlook, you can send and receive email, and create tasks and 

appointments the same way you always have in Outlook. But the add-in alters the Outlook 

interface in a few key ways. For example, CRM for Outlook adds a CRM section to the Home tab 

for email, appointments, contacts, and tasks. It also adds a new CRM tab to the ribbon. 

 

On the left side of the screen, below your email Inbox, you’ll see a new navigation pane with the 

name of your organization and folders you can use to find your way around CRM for Outlook: 

 

These and other interface components make it possible to access all the core Microsoft 

Dynamics CRM features directly from Outlook. 

Next up:       Take advantage of what you already know 
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Take advantage of what you already know 

If you already use Outlook for email, appointments, and tasks, you’ll feel right at home with 

CRM for Outlook. In fact, you’ll instinctively know how to accomplish many tasks. For example, 

you can sort, categorize, and flag your data using the same tools you would use in Outlook: 

 

 

CRM for Outlook also offers features that aren’t available through Microsoft Dynamics CRM. 

We’ll cover those next. 

Next up:       Track your Outlook email, appointments, contacts, and tasks 
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Track your Outlook email, appointments, 

contacts, and tasks  

A big part of working in Microsoft Dynamics CRM is creating and recording different types of 

activities—sending email, creating appointments, creating tasks—that revolve around a sales or 

service process. With CRM for Outlook, you can create these types of activities the same way 

you always do in Outlook, but to record the activities in Microsoft Dynamics CRM, you track 

them. Tracking an email message, appointment, contact, or task is as simple as choosing the 

Track button on the ribbon. 

 

When you track an email, appointment, contact, or task record, a copy of that record is created 

in Microsoft Dynamics CRM. After a record is tracked, you can still access that record from CRM 

for Outlook by choosing View in CRM. You or anyone who has access to your activity records 

can also access them in Microsoft Dynamics CRM.  

You can use the Microsoft Dynamics CRM tracking pane at the bottom of a tracked record to see 

that a record is tracked, and to easily access related records. 

 

Tracking provides a great way to keep your personal Outlook records separate from your 

Microsoft Dynamics CRM records since you track just the records you want to synchronize with 

Microsoft Dynamics CRM. 

Next up:   Enhanced email capabilities make you more productive 
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Enhanced email capabilities make you 

more productive 

After you track an email message in CRM for Outlook, you can access several Microsoft 

Dynamics CRM features from the CRM for Outlook ribbon. For example, if you receive email 

from a potential sales lead, you can convert the email message directly into a CRM lead record. 

Likewise, you can convert email messages into opportunities or cases.  

 

You can also insert a Microsoft Dynamics CRM email template or a Knowledge Base article into 

your email message, or even attach a sales brochure or other sales literature stored in Microsoft 

Dynamics CRM.  

 

All of these features make you more productive because you can work in a single tool that 

you’re already familiar with, but access Microsoft Dynamics CRM features at the same time. 

Next up:   Take your work with you when you go offline 
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Take your work with you when you go 

offline 

One of the great things about CRM for Outlook is you can take your work with you when you 

unplug. For example, if you travel to a customer’s site, you can look up your Microsoft Dynamics 

CRM contacts, review and add new activities, run reports, and more without connecting to the 

Internet. 

CRM for Outlook stores up the changes you make while you’re offline and automatically 

synchronizes them with Microsoft Dynamics CRM when you go back online.  

Could it be any easier? 

 

Next up:   Security settings—What if you can’t access a feature? 
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Security settings ‒ What if you can’t 

access a feature? 

Microsoft Dynamics CRM comes with security settings that control your access to certain 

features, data, or even fields on screens, depending on your role.  

If you can’t see or access something described in this guide, or if some data is marked “read 

only,” check with the person who manages your system day-to-day. You may need to get 

additional security permissions. 

Next section: Get Help when and where you need it 
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Get Help when and where  

you need it 
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Get Help on a specific dialog box, window, 

or error message 

As you use CRM for Outlook, you can access Help for specific windows, dialog boxes, and error 

messages. You can access Help by choosing: 

 The Help button on the ribbon: 

 

 The question mark button in the upper-right corner of a dialog box or window: 

 

 Links in dialog boxes: 

 

 Links or Help buttons in error messages: 

 

Next up:   CRM for Outlook User’s Guide provides in-depth Help 
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CRM for Outlook User’s Guide provides  

in-depth Help 

The guide you’re reading now shows you how to get started with CRM for Outlook. When you 

need more than the basics, you can find in-depth help in the CRM for Outlook User’s Guide.  

 

 

Next up:   Your one-stop shop for Help and training 

Tip 

Make sure to bookmark the URL for the CRM for Outlook User’s Guide to put a wealth 

of CRM for Outlook information at your fingertips! 

http://go.microsoft.com/fwlink/p/?LinkID=524751
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Your one-stop shop for Help and training 

If you need help with other Microsoft Dynamics CRM tasks, go to the Microsoft Dynamics CRM 

Help & Training site at: http://www.microsoft.com/en-us/dynamics/crm-customer-

center/default.aspx 

The Help & Training site provides lots of great content, including task-based Help, short videos, 

eBooks, quick reference cards, walkthroughs, and customizable training content. 

 

Make sure to bookmark the Help & Training site! 

Next section:   Find your data and work with lists 

http://www.microsoft.com/en-us/dynamics/crm-customer-center/default.aspx
http://www.microsoft.com/en-us/dynamics/crm-customer-center/default.aspx
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Find your data and work with lists 
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How CRM for Outlook data is organized 

Although you don’t need to know a lot about databases to start working with CRM for Outlook, 

it’s helpful to know a few things about how data is organized. 

In particular, there are two definitions you should know because they’re used in many places in 

CRM for Outlook: record and record type. 

What’s a record? 

In CRM for Outlook, a record is a complete unit of information. Think of it like a single row in a 

table or a spreadsheet, with multiple columns (or fields) to store the pieces of info that make up 

the entire row. For example, an accounts record might have a column for Account Name, 

Phone, Address, Primary Contact, and so on.  

 

Each time you add a new account to the system, you’re creating a new record in the CRM 

database. 

What’s a record type? 

Each record you add to CRM for Outlook belongs to a certain record type, such as an account, 

contact, lead, opportunity, or case. (CRM for Outlook has several other types of records besides 

these, but these are the ones you’ll probably work with most often.) 

Record types (also called “entities”) give you a way to group and organize similar data.  

Next up:   Find your data 
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Find your data 

If you have worked with Microsoft Dynamics CRM, you know that you get around the system by 

using the navigation bar and tiles: 

 

Your Microsoft Dynamics CRM screen may look different if you’re using an earlier version. 

In CRM for Outlook, the same information is available but through the navigation pane on the 

left side of the screen below your Outlook Inbox. The navigation pane organizes your CRM 

information into folders and subfolders under your organization name, which might be the 

name of your company, or a division within your company if you work for a large company. 

 

Next up:   View records and record details 
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View records and record details 

When you open a folder, such as the Accounts folder or the Leads folder, you’ll see a list of the 

records for that record type. For example, if you open the Accounts folder, you’ll see a list of 

customers with their addresses, phone numbers, and contacts. Lists provide a view of your data 

that’s similar to a spreadsheet—you can see many records at the same time. Use lists to find 

and sort your records. 

When you view a record in a list, you can see some but usually not all of the information for that 

record. For example, some of the columns may scroll off the screen or you may be able to see 

just some of the data in a particular column. If you want to see all the info for a record, just 

select it. The record details will be displayed in the Reading Pane below the list. Keep in mind 

that the information in the Reading Pane is read-only. It’s just a quick way to preview all the info 

about a particular record.  

 

 

Next up:   Edit the data in a record 

Tip 

You can customize the Reading Pane in a number of different ways. We’ll show you 

how later in this guide. 
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Edit the data in a record 

So what if you do want to edit the data in a record? To edit data, you need to open a Microsoft 

Dynamics CRM form. You don’t have to leave CRM for Outlook to do that though. Just double-

click any record in a list to open a Microsoft Dynamics CRM form.  

 

When the Microsoft Dynamics CRM form is open, you can edit the data or do any other actions 

you would normally do in Microsoft Dynamics CRM. 

Next up:   Find a record (fast!) 

Tip 

If you want to edit several records at the same time, select the records you want from 

the list, choose Edit from the ribbon, and then edit the fields you want in the Change 

Multiple Records window.  
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Find a record (fast!) 

Want a quick way to find a record? Use the search box at the top of a list to search for the 

record you want. 

 Type the search term, and then choose the Search icon . Use an asterisk (*) to include a 

wildcard character. 

 

Next up:   View a subset of records 
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View a subset of records 

If you work with a lot of records, it’s helpful to filter the list of records to just the records you 

want. CRM for Outlook comes with several pre-defined filters that you can choose from for each 

record type. For example, you can view all active accounts, or only the accounts you’re 

following. These pre-defined filters are called system views. 

 

When you choose a view from the list, CRM for Outlook creates a tab for that view and pins it 

above the list. This makes it easy to switch among views you use often. Just select the view to 

filter your records, then choose another view to filter them in a different way.  

 

If you choose the Pin button , the views will be available the next time you open CRM for 

Outlook. This keeps the information you use most often at your fingertips. 

Next up:   Create your own filter to select just the records you want 



 

 20 

Create your own filter to select just the 

records you want 

What if the pre-defined views don’t provide the subset of records you need? No worries. You 

can easily create your own custom filters. For example, let’s say you want to know where your 

sales leads are coming from. You know that a lot of them came from people filling out interest 

cards at a trade show. You can create a filter that finds all the Lead records that came by way of 

interest cards.  

1. Choose the drop-down arrow next to Filter in the upper-right corner of a list. 

2. Point to Add Filter, and then in the menu to the left, select a column to filter on. In this case, 

we’ll select the Topic column since that column stores the information about the interest 

cards. 

 

3. In the Custom Filters dialog box, in the first list, choose the drop-down arrow, and then 

select Contains. In the box to the right, enter the words interest card.  

This is what we’re telling CRM for Outlook to do: In the Leads record type, find all the 

records that contain the words interest card in the Topic column. 

Tip 

Want to reuse the same filter again? Choose Save Filters as New View  

from the Filters menu. Your new filter will show up on the same list with the pre-

defined views we used earlier. Filters you save in CRM for Outlook will appear in 

Microsoft Dynamics CRM. 
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Next up:   Add a column to a list 
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Add a column to a list 

What if your list doesn’t include all the columns you want? For example, maybe you want to add 

a second business phone field. It’s simple to add a column. 

1. Right-click any column in a list. 

2. Choose Add Columns. 

3. In the Show Columns dialog box, under Available columns, select the column you want to 

add, and then choose Add. 

 

4. Repeat for any additional columns you want to add. 

Next up:   Sort records in a list 

Note 

To remove a column from a list, just right-click the column, and then choose Remove 

This Column. 
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Sort records in a list 

It’s all about finding the data you need. Sorting provides another tool to help you find records 

fast. 

To sort records in a list, just choose a column heading. For example, if you select the Account 

Name column heading in the list below, CRM for Outlook automatically sorts the list from A to Z. 

If you click the column heading again, it sorts the list from Z to A. 

 

You can also sort records to group similar records together. For example, let’s say the records in 

a list have 4 possible values. If you select the column to sort the records, all the records with the 

same values in that field will be grouped together. This is a quick way to find a subset of records. 

Next up:   Resize and move columns in a list 
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Resize and move columns in a list 

Don’t like the arrangement of columns in your list? Move them around to put information in the 

order that works for you. 

 

 

Next up:   Use color to categorize your records 

Note 

Changes you make to column widths are saved when you close CRM for Outlook; changes you 

make to column order are not saved. 
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Use color to categorize your records 

If you know how to use color to categorize records in Outlook, you already know  

what to do.  

1. In the Categories column, right-click the check box next to the record you want to 

categorize. 

2. Select a color category. 

 

Next section:   Visualize your data with dashboards 

 

Tip 

If you want to rename the color categories to make them more meaningful to you, 

choose the All Categories menu item. To set a single color as the color to apply when 

you click a check box, choose the Set Quick Click menu item.  
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Visualize your data with 

dashboards 
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Start your day with a dashboard 

You may want to start your day by opening a dashboard. A dashboard provides  

easy-to-read lists and charts that help you see how you and your team are doing with key 

metrics (also known as key performance indicators, or KPIs).  

For example, if you’re in sales and you open the Sales dashboard, you’ll see the status of open 

opportunities in the sales pipeline, or how many leads were generated by your marketing 

campaigns.  

 To open a dashboard, in the left navigation pane, open the folder for your area. For 

example, open the Sales folder. Open the My Work subfolder, and then open the 

Dashboards subfolder. 

 

Next up:   Find the right dashboard for your role 
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Find the right dashboard for your role 

CRM for Outlook comes with several different dashboard layouts to help you highlight the data 

and performance metrics you’re most interested in. The best way to find one you like is to take 

a look at a few. 

 To see the different dashboard layouts, choose the drop-down arrow next to the name of 

the dashboard, and then select the layout you want. For example, if you want to see a 

What’s New list on your dashboard, try the Sales Activity Social Dashboard. 

 

Next up:   Set your default dashboard layout 

Tip 

You can modify an existing dashboard if you want to add different lists or charts. 
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Set your default dashboard layout 

When your system is set up, the system administrator picks the default dashboard layout for 

your work area. If you want to see a different dashboard when you go to your work area, you 

can override the default. 

 Use the list of dashboards to select the dashboard you want, and then choose Set as Default 

on the ribbon. 

 

 

 

Next up:   Drill in to see the data that makes up the chart on a dashboard 
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Drill in to see the data that makes up the 

chart on a dashboard 

So where does the data come from for those charts? You can quickly see the underlying data for 

a chart by choosing the Drill in button . You won’t see the button until you point to the chart. 

 

Next up:   Pick a different type of chart or different fields for a chart 
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Pick a different type of chart or different 

fields for a chart 

You can try out different types of charts, and see how your data looks when you use different 

fields for the calculations, right from the dashboard. (No customization required!) 

1. On a dashboard, select a chart segment (for example, a single bar in a bar chart) and then 

select a different type of chart, such as a pie chart or scatter diagram. To try different fields, 

choose the drop-down arrow, and then select from the list. 

 

2. When you’re ready, choose the right arrow icon  to apply your changes. 

Next section:   Email, appointments, tasks, and other assorted CRM activities 
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Email, appointments, tasks, and 

other assorted CRM activities 
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Everything revolves around activities 

In CRM for Outlook, you use activities to keep track of all your customer communications. For 

example, you might send email, make phone calls, set up appointments, assign tasks, or record 

notes as you work a sale. These actions are all considered types of activities. 

 

To get the most out of CRM for Outlook, it’s important for everyone in the organization to track 

all their customer interactions by adding an activity for every email, phone call, task, or 

appointment. That way, a customer’s history is complete. As your organization’s relationship 

with a customer builds over time, you and other people on your team can look through the list 

of activities as you work with the customer, and see the complete history of interactions.  

Sharing information this way also makes it possible to provide key points of interest across the 

business. Activities can be included on dashboards and in reports to track your ongoing progress 

and to monitor how the team is doing. 

Next up:   Find activities for your area      
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Find activities for your area 

Ready to find your activities and get to work? Go to your My Work subfolder. 

 In the left navigation pane, choose the subfolder for your work area (Sales, for example), 

choose the My Work subfolder, and then choose the Activities subfolder. 

 

 

Next up:   View and filter your activities to show only the ones you want      
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View and filter your activities to show only 

the ones you want 

When you choose the Activities subfolder in the left navigation pane, you’ll see the My 

Activities list. This list shows all activities assigned to you. If you want to see a subset of your 

activities, you can choose from the pre-defined system views. For example, you might want to 

focus your efforts on just task activities, or just appointment activities. 

 Choose the drop-down arrow next to My Activities, point to a general area, and then select 

the view you want. For example, point to Phone Call, and then select My Phone Calls. If you 

want to see all activities (not just the activities you own), point to Activity, and then select 

All Activities. 

 

Next up:  Add a new activity by tracking it      

Tip 

As we discussed earlier in this guide, you can create your own filters (views) if the 

pre-defined system views don’t provide exactly what you need. 
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Add a new activity by tracking it 

Adding an activity in CRM for Outlook is different than adding an activity in Microsoft Dynamics 

CRM. As we talked about earlier in this guide, email, appointments, and tasks are types of 

activities in Microsoft Dynamics CRM. When you create one of these activities in CRM for 

Outlook, you need a way to record that activity record so it’s associated with the appropriate 

records in Microsoft Dynamics CRM. For example, you may want to associate a phone call 

activity with a particular sales opportunity. The way you create this association is through 

tracking.  

When you track an email message, appointment, or task in CRM for Outlook, a copy of that 

record is created in Microsoft Dynamics CRM and linked (synchronized) with the Outlook record. 

After a record is tracked, you can continue to access that record in CRM for Outlook, and anyone 

with access to your activities can view that record in Microsoft Dynamics CRM.  

To track an email, appointment, or task activity in CRM for Outlook, when you create the 

activity, you choose the Track button or the Set Regarding button on the ribbon. 

 

If you choose the Track button, CRM for Outlook associates the record with any Microsoft 

Dynamics CRM contacts included on the To, Cc, or Bcc lines by searching for records that have 

matching email addresses. This is great, but it may not be sufficient for your needs. You may 

work with the same contacts over a long period of time, so simply associating a record with a 

contact may not be enough. To track a record and associate it with a more specific record—for 

example, an opportunity or a case—you use the Set Regarding button.  

Next up:   Use the tracking pane to find related records  
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Use the tracking pane to find  

related records  

When you choose the Track button or the Set Regarding button, CRM for Outlook adds a 

Microsoft Dynamics CRM pane at the bottom of the record. This “tracking pane” shows that the 

record is tracked and provides links to any related records. It also displays a link to the Regarding 

record, if you set one. 

 

 

Next up:   Track an incoming email activity  
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Track an incoming email activity 

Most often, you’ll want to track an email activity associated with a contact, opportunity, 

account, service case, or other type of record to help you keep track of all the communications 

with a customer. For example, let’s say you receive an email message from a potential customer 

who wants to know about a product or service your company provides. 

1. In your Inbox (the same Inbox that you use for all other Outlook email), select the email 

message. You don’t need to open the email message to track it. 

2. Choose the Track button or the Set Regarding button on the ribbon. Remember, you can 

choose either button, but it’s usually better to choose the Set Regarding button so you can 

link the email activity to a more specific record. 

3. If you choose the Set Regarding button, choose More. 

4. In the Look Up Record dialog box, if CRM for Outlook has already selected the record type 

you want, you can just select a record in the list by clicking to the left of that record. After 

marking the record, choose Add.  

 

When you choose Add, CRM for Outlook adds the tracking pane at the bottom of the 

record. The tracking pane provides links to the Regarding record and other related records, 

such as contacts. If a contact is displayed in red, it means CRM for Outlook couldn’t find that 

contact in the CRM database. You can click the contact name to easily add the contact or to 

create a lead. CRM for Outlook also adds the Tracked in CRM icon  to the email 

message. 

Tip 

Another way to quickly see a tracked record is to choose the View in CRM button on the 

ribbon. You can also use this button to enter data in fields that are only accessible 

through Microsoft Dynamics CRM forms. 
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Next up:   Create and track an outgoing email activity 
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Create and track an outgoing email activity 

If you’re creating a new email message, tracking the email activity is basically the same process. 

When you compose an email message (or create a new task or set up a new appointment), you 

can search for a Microsoft Dynamics CRM contact directly from the To or Cc field.  

1. Go to your Inbox, and then choose New Email on the ribbon. 

2. Enter one or more email addresses in the To and Cc boxes. If you need to look up a contact, 

select the To box or Cc box. All of the contacts that have been added to Microsoft Dynamics 

CRM will appear in the address book. 

3. Choose the Track button or Set Regarding button as described earlier. 

Next up:   Create and track an appointment activity  

 

Tip 

You can set a personal option to determine which contacts you want to include in the 

address book. For example, you can include just the contacts you own or you can 

synchronize all the contacts in the Microsoft Dynamics CRM database. 
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Create and track an appointment activity 

Adding and tracking an appointment activity is very similar to adding and tracking an email 

activity.  

1. Choose Calendar in the navigation pane at the bottom of the CRM for Outlook window. 

2. On the ribbon, choose New Meeting. 

3. Enter one or more email addresses in the To box.  

4. Enter a Subject, Location, Start time, and End time.  

5. Choose the Track button or Set Regarding button as described earlier. 

Next up:   Create and track a task activity 

 

Tip 

CRM for Outlook remembers the Regarding record that you select and offers that 

record the next time you choose the Set Regarding button. 
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Create and track a task activity 

Adding and tracking a task activity is very similar to adding and tracking an email activity or an 

appointment activity. There are a few key differences to know about though: 

 Microsoft Dynamics CRM has separate activities for phone calls, letters, and faxes. CRM for 

Outlook includes these types of activities within a task activity, so, for example, if you want 

to create a phone call activity, you need to start by creating a task activity. 

 Only the owner of a task activity can track that task. If you want to assign a task to someone 

else, you can track the task before you assign it. The person you assign the task to can track 

the task if it’s not already tracked. 

Create and track a task activity 

1. Choose Tasks in the navigation pane at the bottom of the CRM for Outlook window. You 

may have to choose the More (…) button to access tasks in the navigation pane. 

2. On the ribbon, choose New Task. 

3. Enter a Subject, Start date, and Due date. You may also want to set other options like 

Status, Priority, and Reminder. 

4. To track the task, do one of the following: 

 If you want to track a normal task, choose the Track button or the Set Regarding button.  

 If you want to track the task as a phone call, letter, or fax, choose the drop-down arrow 

on the Track button, and then choose the type of task you want. 

 

5. If you want to assign the record to someone else on your team, choose Manage Task, 

choose Assign Task, and then enter an email address in the To box. 

Next up:       When are records synchronized with Microsoft Dynamics CRM? 

Tip 

You can always set a Regarding record after you track the specific task. Just select the 

task, and then choose the Set Regarding button. 
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When are records synchronized with 

Microsoft Dynamics CRM? 

When you track a record in CRM for Outlook, the data in that record will generally be available 

in Microsoft Dynamics CRM within 15 minutes (it may be available immediately, depending on 

how your administrator sets up synchronization). After a record is synchronized, you or anyone 

who has access to your activities can view that data in Microsoft Dynamics CRM.  

Records added in Microsoft Dynamics CRM are also automatically synchronized with CRM for 

Outlook. So, for example, if you or someone else adds an activity record in Microsoft Dynamics 

CRM, you can view those records in CRM for Outlook. 

By default, records that are synchronized from Microsoft Dynamics CRM are synchronized in 15-

minute intervals. If you don’t want to wait for records to synchronize, you can synchronize 

manually. 

1. In CRM for Outlook, on the File menu, choose CRM. 

2. Choose the Synchronize button, and then choose Start Synchronization. 

 

Next up:   What if you want to stop tracking a record?  
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What if you want to stop tracking a 

record? 

You may occasionally want to stop the synchronization of certain activities between CRM for 

Outlook and Microsoft Dynamics CRM. To stop synchronizing records, you untrack them. 

1. Select the records you want to untrack. 

2. On the ribbon, choose Untrack. 

 

Next up:   Mark your activity complete   
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Mark your activity complete 

After you call someone, complete a task, send an email, or go to an appointment, you can mark 

the activity for that action as completed. When you mark an activity complete, CRM for Outlook 

moves the activity to the Closed Activities view. 

1. Open the activity record. 

2. On the ribbon, choose Mark Complete. 

 

Next up:   Flag an activity for follow up 

Tip 

To mark several activities complete at the same time, select each activity in the My 

Activities list, and then choose Mark Complete on the ribbon. To select multiple 

activities, you can hold down the Shift key, or you can hold down the Ctrl key to select 

records that aren’t next to each other. 
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Flag an activity for follow up 

Want to make sure you don’t forget to follow-up on an important activity? Flag it. You can also 

set a reminder to make sure you don’t forget to follow up on those really important activities. 

Flagging an activity in CRM for Outlook is exactly the same as flagging an email message or other 

activity in Outlook. 

1. To flag an activity to follow up today, select the flag for the activity record. 

 

2. If you want to set a different time period for following up, or if you want to set a reminder, 

right-click the flag, and then select the appropriate option. 

 

Next up:   Best practices for activities 
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Best practices for activities 

Now that you have a handle on how to work with CRM activities, here are some suggestions 

about how to use them to your organization’s best advantage: 

 Add an activity for every customer interaction. Make sure a customer’s history includes a 

record of every communication you have with them. 

 Add activities for yourself, too. You can keep track of your own assignments and events 

without associating these activities with a customer. Just choose the Track button instead of 

the Set Regarding button.  

To find these activities in a list, sort on the Regarding column. If the data for the Regarding 

column is blank, the activity isn’t associated with a customer record.  

If you want to create an activity that isn’t recorded in Microsoft Dynamics CRM, don’t track 

it at all. 

 Keep in mind that activities “roll up” under their associated records. Let’s say you want to 

remind yourself to follow up with Chris Preston, a contact who’s associated with the 

account, Imported Sports. It’s best to track the task activity to the contact record for Chris, 

not the account record for Imported Sports.  

The contact record is associated with the account record, so if you track the task to the 

contact record, your task will “roll up” under the account automatically, and you and the 

people on your team will see the task when they’re looking at the contact, and when they’re 

looking at the account record for Imported Sports.  

Next section: Nurture leads through the sales process 
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Nurture leads through the  

sales process 
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Tell me about accounts, contacts, leads, 

and opportunities 

Account and contact records store much of the information that you and your team collect from 

your customers. 

You store data about companies you do business with in accounts. You store data about the 

people you know and work with in contacts. 

Usually, an account has more than one contact associated with it, especially when you’re 

working with a larger company with many departments or locations and you deal with several 

people to manage the account. 

Leads are for potential sales, and most organizations get leads from many sources. For example, 

you can enter leads manually from business cards, generate them from marketing campaigns or 

inquiries from your website, buy them in mailing lists, create them automatically from posts on 

Facebook or Twitter—the possibilities are almost endless. 

If all goes well, after you nurture a lead, you’ll be able to promote the lead to an opportunity, 

which is another name for a deal you’re getting ready to close. 

What if you see different names for the types of records in your system? 

One of the beauties of Microsoft Dynamics CRM is that it’s so easy to customize to match your 

organization’s industry, business goals, or preferences. If your Microsoft Dynamics CRM system 

has been heavily customized, you may see different names for the types of records in CRM for 

Outlook because your organization calls that type of data something different. For example, 

your system administrator may have changed “account” to “company,” or “contact” to 

“individual.” 

Next up:   Why would I want to add my Outlook contacts to Microsoft Dynamics CRM? 
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Why would I want to add my Outlook 

contacts to Microsoft Dynamics CRM? 

If you have worked with Outlook for a while, you probably have a lot of contacts. To take full 

advantage of Microsoft Dynamics CRM and all that it has to offer, you’ll want to add your 

Outlook contacts to Microsoft Dynamics CRM. That way, you can track all customer-related 

activities in one place. After adding and linking your Outlook contacts to accounts in Microsoft 

Dynamics CRM, you’ll see the email, tasks, and appointments records associated with those 

contacts in CRM for Outlook. You (or others if they have access to your activities) will also be 

able to access those contact records in Microsoft Dynamics CRM. In other words, it works both 

ways. 

Also, if you sync Outlook on your smart phone or other mobile device, you can access your CRM 

contacts from that device. 

But what about personal contacts? 

If you’re like most people, you probably mix your Outlook business contacts with some personal 

contacts. CRM for Outlook makes it easy to keep your personal contacts separate from your 

business contacts. Your personal contacts will never show up in Microsoft Dynamics CRM unless 

you decide to track them. 

Next up:   Add Outlook contacts to Microsoft Dynamics CRM 
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Add Outlook contacts to Microsoft 

Dynamics CRM 

You can add your contact records to Microsoft Dynamics CRM in the same way that you add an 

activity record—by tracking them. Earlier in this guide, we showed how to link an activity record 

to a particular record, such as an opportunity or case by using the Set Regarding button. With 

contacts, you can do the same thing, but you link the contact to a Microsoft Dynamics CRM 

account instead. 

1. In CRM for Outlook, choose People in the navigation pane. 

2. Select up to 20 contacts. (Hold down the Shift key to select multiple contacts next to each 

other or the Ctrl key to select contacts that aren’t next to each other.) 

3. On the ribbon, do one of the following: 

 Choose the Track button to copy the contact record to Microsoft Dynamics CRM 

without linking the contact to an existing account record.  

 Choose the Set Parent button to copy the contact record to Microsoft Dynamics CRM 

and link it to an account record at the same time. 

 

4. If you choose the Set Parent button, in the Look Up Record dialog box, select the account 

name to link the contact to, and then choose Add. 

When you track a contact, CRM for Outlook displays the tracking pane below the person’s 

contact card. The tracking pane shows that the contact is tracked and provides a link to the 

account record if you used the Set Parent button to track the record. 

Next up:   Add all (or lots!) of Outlook contacts to Microsoft Dynamics CRM 

Tip 

If you want to fill in specific fields in Microsoft Dynamics CRM that aren’t available in the 

Outlook form, choose the View in CRM button. 
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Add all (or lots!) of contacts to  

Microsoft Dynamics CRM 

What if you want to add more than 20 contacts at a time, or if you want to add all of your 

Outlook contacts to Microsoft Dynamics CRM? There’s a wizard for that. 

1. Before you run the wizard, make sure your Outlook contact data is as complete and as 

accurate as possible. For example: 

 

 Fill in any missing info and verify that people’s names are spelled correctly.  

 Make sure that account names use the same spelling in Outlook and Microsoft 

Dynamics CRM. This will make it easier to link the contacts to the appropriate accounts. 

You may also want to put all of the contacts you want to track into a single folder, or 

organize contacts into particular folders. 

2. On the File menu, choose CRM. 

3. Choose the Import Contacts button, and then choose Add Contacts from the  

drop-down menu. 

4. Follow the steps in the wizard screens. If you get stuck anywhere in the process, click the 

Learn more about adding contacts to CRM link at the bottom of any wizard screen. 

 

Next up:   Convert an email message to a lead 
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Convert an email message to a lead 

So you’re ready to start creating your own leads. As we discussed earlier, leads can come from 

many different sources, but one of the easiest ways to create them is directly from an Outlook 

email message. For example, let’s say someone has sent an email message to your website 

inquiring about a product or service your business offers. You can convert the email message to 

a lead. 

1. Select the email message in your Inbox, and then choose Track on the ribbon. You must 

track the email message before you can convert it. 

2. On the ribbon, choose Convert To, and then choose Lead. As you can see, you can also 

convert email messages into opportunities or cases, but we’ll focus on leads for now. 

 

3. In the Convert to Lead dialog box, add a first name and last name for the contact, and a 

company name. 

4. Choose Convert. 

CRM for Outlook creates the lead in Microsoft Dynamics CRM and opens that record in the 

Microsoft Dynamics CRM Leads form.  

5. Fill out the information in the Leads form. 

Next up:   It’s all in the (business) process      

 

Tip 

Looking for another easy way to create leads from an email message? When you 

receive email from someone who isn’t already included in the Microsoft Dynamics 

CRM database, if you track the email message, that person’s email address will be 

highlighted in red in the tracking pane. Just click the email address and then choose 

Contact or Lead to add to Microsoft Dynamics CRM. 
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It’s all in the (business) process 

So what do you do with leads after they’ve been added to Microsoft Dynamics CRM? Hopefully, 

you can turn these leads into opportunities and then eventually close the deal. But what’s the 

best way to work through that process?  

Microsoft Dynamics CRM helps you move customers through the sales process by using a visual 

process bar. You complete a step by entering data or marking a step complete in the process 

bar. When all the steps are done, you can move on to the next stage. The process bar highlights 

the stage you’re in so you know where you are in the process, and shows you what to do next. 

No guesswork! 

 

For example, the business process in the illustration above starts with a lead. As the first step in 

the process, you qualify or disqualify the lead based on criteria established by the business. If 

you qualify the lead, it’s converted to an opportunity. The business process then walks you 

through the stages of the opportunity: 1) Qualify; 2) Develop; 3) Propose; 4) Close.  

Your team can use these standardized processes to make sure everyone on the team follows the 

same steps and has the same interactions with customers as you move them through the sales 

process. Business processes help everyone follow best practices, even when handling situations 

that don’t occur very often. 

Next up:   Disqualify a lead 
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Disqualify a lead 

Let’s say that after talking to one of your leads, you determine that continuing to work that lead 

won’t be worth your time, at least not for now. Not great news, but it happens. 

You’ll need to disqualify the lead, and give the reason. While you could delete the lead, we don’t 

recommend that. Deletions can’t be undone, and deleting a lead also deletes any notes and 

documents associated with the lead. Instead, disqualify the lead to preserve the history. In 

addition, disqualifying the lead allows you to re-open the lead later if needed. 

1.  Open the Leads list, and then double-click a lead record to open it. 

When the CRM form opens, you’ll see the business process bar.  

2. On the command bar in the Microsoft Dynamics CRM form, choose Disqualify, and then 

select the reason. For example, select No Longer Interested. 

 

When you choose Disqualify, CRM adds a Locked icon next to fields in the form. CRM for 

Outlook also moves the lead to the Closed Leads list. Why is that important to know? If you 

find that you need to reactivate that lead later, you’ll need to know where to find it. 

3. Close the CRM form to return to CRM for Outlook. 

Next up:   What if you want to re-open a lead that you thought wasn't interested? 

Note  

You can also use a button on the CRM for Outlook ribbon to quickly disqualify a lead, 

but the ribbon doesn’t provide access to the business process bar.  
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What if you want to re-open a lead 

that you thought wasn't interested? 

Great news! The lead you thought wasn’t interested has contacted you, and it looks like the 

person will buy after all. Assuming that you disqualified the lead (instead of deleting it), you can 

re-open it without re-entering all the contact information. 

1. Open the Leads list, choose the drop-down arrow to see other views, and then select the 

Closed Leads view. 

 

2. In the Closed Leads list, double-click the record for the lead you disqualified. 

3. In the Microsoft Dynamics CRM form, in the command bar at the top of the screen, choose 

Reactivate Lead.  

4. If you’re ready to qualify the lead, on the command bar, choose Qualify. 

In the process bar, you’ll see that you’ve moved to the Opportunity stage. 

5. Close the CRM form to return to CRM for Outlook. 

Next up:   Add stakeholders to your opportunity 
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Add stakeholders to your opportunity 

You’ve qualified your lead, and now you’re in the opportunity stage. As you work on converting 

the opportunity into a closed sale, you’ll want to add key stakeholders and decision makers who 

can help you win the business. 

1. Go to the Opportunities subfolder and open the Opportunities list. You can find it just below 

the Leads subfolder. 

2. In the Opportunities list, double-click the record you want to add stakeholders to. 

3. In the Stakeholders section of the Microsoft Dynamics CRM form, choose the Add button , 

and then select the person’s name. 

 

Next up:  Send a sales brochure to a potential customer 
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Send a sales brochure to a potential 

customer 

Your prospect is interested in your product. They send you email asking for a sales brochure. If 

your sales brochure is stored in Microsoft Dynamics CRM, you can send it directly from CRM for 

Outlook with minimal effort. 

1. If the email message isn’t already tracked, track it by choosing the Track button. 

2. On the ribbon, choose Attach Sales Literature. 

 

3. Select More Sales Literature, and then browse to the sales information that will help you 

close the deal. 

Next up:   Send a sales proposal or a price quote 

Note  

If you have recently attached sales literature to another email message, it will be 

available from the list.  
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Send a sales proposal or a price quote 

As you move your prospect through the sales cycle, you’ll probably need to send a detailed 

proposal that includes products and a price quote. 

Because you may need to go back-and-forth with the prospect, the system keeps track of the 

history for you. 

1. Open the Opportunities list, and then double-click the appropriate record to open the 

Microsoft Dynamics CRM form. 

2. In the Product Line Items section, choose the Add button , and then select the products. 

(Scroll down to see the Product Line Items section.) 

3. In the Quotes section, choose the Add button , and then fill in the fields to create the 

quote. (You may need to scroll down to see the Quotes section.)  

4. On the command bar, choose Activate Quote. 

 

5. Close the form to go back to CRM for Outlook. 

Next up:   Close your opportunity as won or lost        



 

 60 

Close your opportunity as won or lost 

Eventually you’ll know whether you’ve won or lost a deal. Then you’ll need to close the 

opportunity and enter a few details about the reason. 

1. Go to the Opportunities list, and then double-click to open the appropriate record. 

2. On the command bar, choose Close As Won or Close As Lost. 

3. Select the reason from the drop-down list, and then enter a brief description of why.  

 

Next section:   Take your work with you and go offline        
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Take your work with you and go  

offline 
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Select just the data you need before you 

go offline 

One of the great things about CRM for Outlook is that you can use it to take your CRM data with 

you when you’re on the go. For example, if you travel to a customer’s site, you can look up your 

CRM contacts, review and add new activities, run reports, and more without connecting to the 

Internet. 

CRM for Outlook stores up the changes you make while you’re offline and automatically 

synchronizes them with Microsoft Dynamics CRM when you go back online.  

But before you go offline, it’s a good idea to think about the data you want to take with you. For 

example, CRM for Outlook automatically synchronizes the appointments, contacts, and task 

records you own to your local hard drive. If that’s all you need, you’re all set. But what if you 

want to synchronize records you don’t own? Or maybe you want to make the synchronization 

process go faster by synchronizing a smaller subset of data? You can synchronize just the data 

you need by modifying the offline filters. 

 

Next up:   Open an offline filter      
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Open an offline filter 

You’re about ready to head out on a trip to a client site. If you don’t modify your offline filters 

before you go, you’ll have access to all the reports you own, but you want to also have access to 

your team reports while you’re offline. In this example, we’ll modify an existing offline filter and 

then save it as a new filter. 

1. On the File menu, choose CRM. 

2. Choose the Go Offline button, and then select Manage Offline Filters from the list. 

3. In the Go Offline Settings dialog box, choose the Outlook offline Reports filter. 

 

4. In the New Filter window, you’ll see the criteria that defines the existing filter. 

 

Next up:   Modify an offline filter to include additional reports        
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Modify an offline filter to include  

additional reports 

Now we’ll edit the existing filter so that it selects all the reports owned by your team.  

1. Choose the drop-down arrow next to Equals Current User, and then select Equals Current 

User or User’s Teams. 

 

2. On the command bar, choose Save As, give the filter a new name like All team reports, add 

a Description, and then choose Save. 

3. Close the New Filter dialog box to return to the Go Offline Settings dialog box. 

4. If you scroll to your new filter, you’ll see that the filter is active. 

Next up:   What else can you do with offline filters?        

Tip 

You could also just save the existing filter and modify it permanently but it’s often 

better to create a new filter. This gives you the flexibility of using different filters for 

different needs. 
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What else can you do with offline filters? 

Offline filters in CRM for Outlook are very powerful and flexible. You can create a different set of 

filters for different situations. For example, you could create one set of filters that you use when 

you travel to a particular region and another set of filters for a different region. You can easily 

activate or deactivate filters depending on your needs by choosing buttons in the Go Offline 

Settings dialog box.  

 

Also, keep in mind that you can have more than one active filter at a time, which offers ultimate 

flexibility. Each filter just adds to the data that’s synchronized with your computer. 

You can use the criteria rows in filters to make simple modifications, or you can create complex 

criteria. It’s up to you! For more information on working with criteria rows, search for offline 

filters in the Customer Center. 

Next up:   Go offline, and then go back online 
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Go offline, and then go back online 

You’ve selected the data you need for your trip. You’re ready to unplug.  

 On the File menu, choose CRM, choose the Go Offline button, and then choose Go Offline 

from the drop-down menu. 

 

When you choose Go Offline, CRM for Outlook synchronizes your data to your local computer 

using the offline filters. When synchronization is complete, you can disconnect your computer 

from the network. 

When you go offline, the Go Offline button changes to Go Online. The CRM toolbar and the 

CRM tab will also display the Go Online button. So now you also know how to go back online! 

Next section:   Make it your own        
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Make it your own 
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Set personal options 

You can set personal options in CRM for Outlook to set things up for the way you work. Most of 

the options that you can set in CRM for Outlook have to do with tracking and synchronization. 

We’ll highlight a few of the more common options in this section. But first, let’s learn how to set 

a personal option. 

1. On the File menu, choose CRM. 

2. Choose the Options button. 

CRM for Outlook displays the Set Personal Options dialog box, which includes tabs for the 

different types of options. 

 

Next up:   Track incoming email automatically 
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Track incoming email automatically 

As we talked about earlier in this guide, tracking email in CRM for Outlook is a manual process. 

You select the email you want to track, and then you choose the Track button or the Set 

Regarding button. Manual tracking provides a way to keep your personal email separate from 

your Microsoft Dynamics CRM email. As an alternative, you can set an option to track email 

messages automatically. 

1. Open the Set Personal Options dialog box, and then choose the Email tab. 

2. Under the Select how Microsoft Dynamics CRM for Outlook should integrate email with 

Microsoft Dynamics CRM section, select the Check incoming email in Outlook and 

determine whether an email should be linked and saved as a Microsoft Dynamics CRM 

record option. 

 

3. Now you need to decide whether to track all email messages or only certain types. To do 

that, in the Select the email messages to track in Microsoft Dynamics CRM section, in the 

Track list, select an option. In most cases, you’ll want to select the Email messages in 

response to CRM email option. 

Next up:   Automatically create contacts or leads from unknown email addresses        



 

 70 

Automatically create contacts or leads 

from unknown email addresses 

Here’s a fast way to add contacts or leads using CRM for Outlook. You can set a personal option 

to automatically create them when you track an email or appointment record if the email or 

appointment record includes an unknown email address. 

1. Open the Set Personal Options dialog box, and then choose the Email tab. 

2. Under Automatically create records in Microsoft Dynamics CRM, make sure the Create 

check box is selected, and then choose Contacts or Leads from the list. 

 

Next up:   Set the number of records you see in lists        
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Set the number of records you see in lists 

By default, when you view records in a list, CRM for Outlook displays 50 records per page. You 

can change this number to display more or fewer records. 

 In the Set Personal Options dialog box, choose the General tab, and then under Set the 

number of records shown per page in any list of records, select the number you want. 

 

Next up:   Set whether to open Outlook forms or Microsoft Dynamics CRM forms       
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Set whether to open Outlook forms or 

Microsoft Dynamics CRM forms 

Throughout this guide, we’ve shown how you can track email, appointments, contacts, and tasks 

by choosing the Track button or the Set Regarding button (Set Parent button for contacts). 

Tracking is very simple, and it enables you to work with the same Outlook interface that’s 

probably already familiar to you. 

You also have the option to open Microsoft Dynamics CRM forms directly, however, when you 

want to create an activity record or contact record. If you use the Microsoft Dynamics CRM 

forms, you don’t need to track your activities and contacts. 

Using the Microsoft Dynamics CRM forms can also be useful if someone has customized 

Microsoft Dynamics CRM. For example, a CRM admin may have added fields that aren’t 

available through the normal Outlook forms. 

Use Microsoft Dynamics CRM forms for new activities 

 In the Set Personal Options dialog box, choose the General tab, and then under Select 

which forms to use for new activities, select one or more check boxes. For example, if you 

want to automatically open the Microsoft Dynamics CRM form when you create a new task, 

select the Task check box. 

 

Next up:   Customize the Reading Pane to add or remove sections  
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Customize the Reading Pane to add or 

remove sections 

When you click a record in a list, you can view the details (read only) for the record in the 

Reading Pane below the list. You can customize the Reading Pane to add or remove sections. For 

example, for Leads records, you can add or remove the Marketing Information section. You can 

also change the order of info in the Reading Pane. 

1. Open the list for a particular record type. For example, if you want to adjust what you see 

for Leads records, open the Leads list. 

2. On the View tab, choose Customize Reading Pane. 

3. In the Personalize Reading Pane dialog box, do one of the following: 

 If you want to remove information from the Reading Pane, under Displayed Sections, 

select the section you want to remove, and then choose Remove. 

 If you want to add a section, under Available Sections, select the section you want to 

add, and then choose Add. 

 If you want to change the order of sections, select a section, and then click the up or 

down arrow below the Displayed Sections list. 

 

 

 Next up:      Change the position of the Reading Pane or turn it off 
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Change the position of the Reading Pane 

or turn it off 

You can also move the Reading Pane to another position on the screen or turn it off altogether. 

1. On the ribbon, choose View. 

2. In the Layout section, choose Reading Pane, and then choose Right, Bottom, or Off.  

 

3. If you want to mark items as read that you’ve viewed in the reading pane, choose the 

Options button, and then select one or more options from the list. 

Last one:      Next steps 
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Next steps 

Okay, now you’ve covered the basics, and you’re ready to start turning your customers into 

lifelong fans of your products and services. We wish you the best! 

Find more answers and training online 

 To find in-depth information and videos on CRM for Outlook, go to the CRM for Outlook 

User’s Guide. 

 To learn about Microsoft Dynamics CRM basics, check out the CRM Basics eBook. 

 To find more eBooks, videos, and other great content to help you get the most out of 

Microsoft Dynamics CRM, go to the CRM Help & Training site at 

www.CRMCustomerCenter.com. 

 

 

Talk to us 

Is this the kind of guide you’d like to see more of? Did we leave something out you’d 

like to know about? We’d love to know what helps you, or what doesn’t work so well. 

Please take a minute to send us a quick note. We’ll use your feedback to improve our 

content. 

 

http://go.microsoft.com/fwlink/p/?LinkID=524751
http://go.microsoft.com/fwlink/p/?LinkID=524751
http://go.microsoft.com/fwlink/p/?LinkID=512927
http://www.crmcustomercenter.com/
mailto:mscrmdf@microsoft.com?subject=eBook:%20CRM%20for%20Outlook%20Basics%20Guide(/1:help/2:V7/3:V7/4:eBook-CRM-Basics.htm/5:None/6:en-us/7:OP/8:CRM)&body=Thanks%20for%20taking%20the%20time%20to%20send%20us%20your%20feedback.%20What%20would%20you%20like%20to%20let%20us%20know%20about%20the%20CRM%20for%20Outlook%20Basics%20guide?
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